Integrated Configuration Environment (ICE) for Cisco Unified Contact Center Management Portal, Release 12.5(1)

For Unified Contact Center Enterprise

Published: January, 2020
THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCBs public domain version of the UNIX operating system. All rights reserved. Copyright 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: http://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company.

© 2012-2020 Cisco Systems, Inc. All rights reserved.
Table of Contents

Table of Contents ................................................................. 3
Preface ......................................................................................... 7
  About This Guide .................................................................. 7
    Who Should Read This Document ........................................... 7
  Product Naming Conventions .................................................. 7
  Related Documentation ........................................................ 8
  Communications, Services, and Additional Information ............... 8
    Cisco Bug Search Tool .......................................................... 9
  Field Alerts and Field Notices ................................................. 9
  Documentation Feedback ........................................................ 9
  Document Conventions .......................................................... 9

Introduction to ICE ...................................................................... 11
  About ICE ............................................................................ 11
  Using ICE ............................................................................. 12
    Starting ICE ....................................................................... 12
    ICE Menu and Toolbar ....................................................... 12
    ICE Tool Selection ............................................................. 13
    ICE Tool Area .................................................................... 14
    ICE Output Pane ................................................................ 15

Cluster Configuration .................................................................. 17
  About Cluster Configuration .................................................. 17
  Description ........................................................................... 17
  The Cluster Configuration Model ............................................ 17
  Equipment Mappings .............................................................. 18
    Equipment Mappings and Importer Behavior ......................... 18
    Equipment Mappings and the User Interface ......................... 18
  Changing Ownership by Moving Items ...................................... 20
  Importing Remote Ownership Changes .................................... 21

Cluster Configuration Tool Reference ....................................... 21
Cluster Configuration Actions ....................................................... 21
Cluster Configuration Preferences ............................................... 22
Cluster Configuration Filters .......................................................... 23
Cluster Configuration User Interface ............................................... 23
Cluster Configuration Error List Pane ............................................ 25
Setup Page .................................................................................... 26
Servers Page .................................................................................. 26
Resources Page .............................................................................. 28
Logical Resources ........................................................................... 30
Properties of Logical Resources ..................................................... 30
Physical Resources ......................................................................... 33
Properties of Physical Resource Objects ......................................... 34
Properties of Physical Resource Components .................................. 36
Connections ..................................................................................... 38
Equipment Mappings Page ............................................................. 43
Connections Page ............................................................................. 45
Diagnostic Portal Support ............................................................... 48

Replication Manager ....................................................................... 50
About Replication Manager ............................................................. 50
The Replication Manager Setup Tab ............................................... 50
About the Replication Manager Setup Tab ........................................ 50
Unified CCMP Database Server Properties ...................................... 50
Distributor Properties ....................................................................... 51
The Replication Manager Monitor Tab .............................................. 52
About the Replication Manager Monitor Tab ..................................... 52
Monitor Panes .................................................................................. 52
Using Replication Manager ............................................................ 53
Starting Replication Manager .......................................................... 53
Configuring Replication ................................................................. 53
Disabling Replication ..................................................................... 53
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Monitoring Replication</td>
<td>53</td>
</tr>
<tr>
<td>Identifying Replication Errors</td>
<td>54</td>
</tr>
<tr>
<td>More about Replication</td>
<td>55</td>
</tr>
<tr>
<td>Performance Considerations</td>
<td>55</td>
</tr>
<tr>
<td><strong>Failover Manager</strong></td>
<td>56</td>
</tr>
<tr>
<td>About Failover Manager</td>
<td>56</td>
</tr>
<tr>
<td>Using Failover Manager</td>
<td>56</td>
</tr>
<tr>
<td>Preparing to Use the Failover Manager</td>
<td>56</td>
</tr>
<tr>
<td>Starting the Failover Manager Tool</td>
<td>56</td>
</tr>
<tr>
<td>Performing a Failover Operation</td>
<td>58</td>
</tr>
<tr>
<td>More About Failover Manager</td>
<td>59</td>
</tr>
<tr>
<td>Provisioning Service</td>
<td>59</td>
</tr>
<tr>
<td>Data Import Service</td>
<td>59</td>
</tr>
<tr>
<td><strong>Service Manager</strong></td>
<td>60</td>
</tr>
<tr>
<td>About Service Manager</td>
<td>60</td>
</tr>
<tr>
<td>Using Service Manager</td>
<td>60</td>
</tr>
<tr>
<td>Starting Service Manager</td>
<td>60</td>
</tr>
<tr>
<td>Starting Services</td>
<td>60</td>
</tr>
<tr>
<td>Stopping Services</td>
<td>61</td>
</tr>
<tr>
<td>Restarting Services</td>
<td>61</td>
</tr>
<tr>
<td>Sorting Services</td>
<td>61</td>
</tr>
<tr>
<td>Filtering Services</td>
<td>62</td>
</tr>
<tr>
<td>Using the Shortcut Menu</td>
<td>62</td>
</tr>
<tr>
<td><strong>System Properties Manager</strong></td>
<td>64</td>
</tr>
<tr>
<td>About System Properties Manager</td>
<td>64</td>
</tr>
<tr>
<td>Using System Properties Manager</td>
<td>64</td>
</tr>
<tr>
<td>Starting System Properties Manager</td>
<td>64</td>
</tr>
<tr>
<td>System Properties Reference</td>
<td>65</td>
</tr>
<tr>
<td>Global Properties Tab</td>
<td>65</td>
</tr>
<tr>
<td>User Provisioning</td>
<td>70</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Local Properties Tab</td>
<td>70</td>
</tr>
<tr>
<td>Resource Properties Tab</td>
<td>71</td>
</tr>
<tr>
<td>Capacity Properties Tab</td>
<td>71</td>
</tr>
<tr>
<td>Gadget Provider Manager</td>
<td>73</td>
</tr>
<tr>
<td>Custom Dimension Editor</td>
<td>74</td>
</tr>
<tr>
<td>About the Custom Dimension Editor</td>
<td>74</td>
</tr>
<tr>
<td>Description</td>
<td>74</td>
</tr>
<tr>
<td>Custom Dimensions</td>
<td>74</td>
</tr>
<tr>
<td>Using the Custom Dimension Editor</td>
<td>74</td>
</tr>
<tr>
<td>Starting the Custom Dimension Editor</td>
<td>74</td>
</tr>
<tr>
<td>Adding a Custom Dimension Item</td>
<td>75</td>
</tr>
<tr>
<td>Editing a custom dimension item</td>
<td>75</td>
</tr>
<tr>
<td>Deleting a Custom Dimension Item</td>
<td>76</td>
</tr>
<tr>
<td>Moving a Custom Dimension Item</td>
<td>76</td>
</tr>
<tr>
<td>ICE Diagnostic Support</td>
<td>77</td>
</tr>
<tr>
<td>About ICE Diagnostic Support</td>
<td>77</td>
</tr>
<tr>
<td>Diagnostic Features</td>
<td>77</td>
</tr>
<tr>
<td>Using ICE Diagnostic Support</td>
<td>77</td>
</tr>
<tr>
<td>Installing the Cisco Diagnostic Portal</td>
<td>77</td>
</tr>
<tr>
<td>Configuring ICE Integration with the Portal</td>
<td>77</td>
</tr>
<tr>
<td>Viewing Logs</td>
<td>78</td>
</tr>
</tbody>
</table>
Preface

About This Guide

This document describes the Unified CCMP Integrated Configuration Environment (ICE) tool. ICE is a centralized tool that provides easy access to most of the configuration options available within the Unified CCMP platform.

Who Should Read This Document

This document is intended for network and system administrators who are familiar with network services, routing operations and administration.

Product Naming Conventions

In this release, the product names defined in the table below have changed. The New Name (long version) is reserved for the first instance of that product name and in all headings. The New Name (short version) is used for subsequent instances of the product name.

Note: This document uses the naming conventions provided in each GUI, which means that in some cases the old product name is in use.

<table>
<thead>
<tr>
<th>Old Product Name</th>
<th>New Name (long version)</th>
<th>New Name (short version)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco IPCC Enterprise Edition</td>
<td>Cisco Unified Contact Center Enter</td>
<td>Unified CCE</td>
</tr>
<tr>
<td>Cisco IPCC Hosted Edition</td>
<td>Cisco Unified Contact Center Hosted</td>
<td>Unified CCH</td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM) Enterprise Edition</td>
<td>Cisco Unified Intelligent Contact Management (ICM) Enterprise</td>
<td>Unified ICM</td>
</tr>
<tr>
<td>Cisco Intelligent Contact Management (ICM) Hosted Edition</td>
<td>Cisco Intelligent Contact Management (ICM) Hosted</td>
<td></td>
</tr>
</tbody>
</table>
Related Documentation

Documentation for Cisco Unified ICM/Contact Center Enterprise & Hosted, as well as related documentation, is accessible from Cisco.com at:

Related documentation includes the documentation sets for:

- Cisco CTI Object Server (CTIOS), Cisco Agent Desktop (CAD)
- Cisco Agent Desktop - Browser Edition (CAD-BE)
- Cisco Unified Contact Center Domain Manager
- Cisco Unified Customer Voice Portal (CVP)
- Cisco Unified IP IVR, Cisco Unified Intelligence Center
- Cisco Support Tools

For documentation for these Cisco Unified Contact Center products, go to https://www.cisco.com/cisco/web/psa/default.html.

Documentation for Cisco Unified Communications Manager is accessible from:

Technical Support documentation and tools are accessible from:

The Product Alert tool is accessible from (sign in required): https://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice.

For information on the Cisco software support methodology, refer to Software Release and Support Methodology: ICM/IPCC available at (sign in required):

For a detailed list of language localizations, refer to the Cisco Unified ICM/Contact Center Product and System Localization Matrix available at the bottom of the following page:

Communications, Services, and Additional Information

- To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.
- To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.
- To submit a service request, visit Cisco Support.
To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit Cisco Marketplace.

To obtain general networking, training, and certification titles, visit Cisco Press.

To find warranty information for a specific product or product family, access Cisco Warranty Finder.

Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides you with detailed defect information about your products and software.

Field Alerts and Field Notices

Cisco products may be modified or key processes may be determined to be important. These are announced through use of the Cisco Field Alerts and Cisco Field Notices. You can register to receive Field Alerts and Field Notices through the Product Alert Tool on Cisco.com. This tool enables you to create a profile to receive announcements by selecting all products of interest.

Log into www.cisco.com and then access the tool at https://www.cisco.com/cisco/support/notifications.html

Documentation Feedback

To provide comments about this document, send an email message to the following address: contactcenterproducts_docfeedback@cisco.com

We appreciate your comments.

Document Conventions

This document uses the following conventions:
<table>
<thead>
<tr>
<th><strong>Convention</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong> font</td>
<td>Boldface font is used to indicate commands, such as entries, keys, buttons, folders and submenu names. For example:</td>
</tr>
<tr>
<td></td>
<td>- Choose <strong>Edit &gt; Find</strong></td>
</tr>
<tr>
<td></td>
<td>- Click <strong>Finish</strong></td>
</tr>
<tr>
<td><strong>italic</strong> font</td>
<td>Italic font is used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>- To introduce a new term; for example:</td>
</tr>
<tr>
<td></td>
<td>- A <em>skill group</em> is a collection of agents who share similar skills</td>
</tr>
<tr>
<td></td>
<td>- For emphasis; for example:</td>
</tr>
<tr>
<td></td>
<td>- <em>Do not</em> use the numerical naming convention</td>
</tr>
<tr>
<td></td>
<td>- A syntax value that the user must replace; for example:</td>
</tr>
<tr>
<td></td>
<td>- IF (<em>condition</em>, <em>true-value</em>, <em>false-value</em>)</td>
</tr>
<tr>
<td></td>
<td>- A title of a publication; for example:</td>
</tr>
<tr>
<td></td>
<td>- Refer to the <em>Cisco CRS Installation Guide</em></td>
</tr>
<tr>
<td><strong>window font</strong></td>
<td>Window font, such as Courier, is used for the following:</td>
</tr>
<tr>
<td></td>
<td>- Text as it appears in code or that the window displays; for example:</td>
</tr>
<tr>
<td></td>
<td>- <code>&lt;html&gt;&lt;title&gt;Cisco Systems, Inc. &lt;/title&gt;&lt;/html&gt;</code></td>
</tr>
<tr>
<td><strong>&lt; &gt;</strong></td>
<td>Angle brackets are used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>- For arguments where the context does not allow italic, such as ASCII output</td>
</tr>
<tr>
<td></td>
<td>- A character string that the user enters but that does not appear on the window, such as a password</td>
</tr>
</tbody>
</table>
Introduction to ICE

About ICE

The Integrated Configuration Environment (ICE) application is a centralized tool that provides easy access to most of the configuration options available within the Unified CCMP platform. Individual configuration tools are components within ICE.

The ICE application supplied with Unified CCMP has the following components:

- **Cluster Configuration**
  - Provides functionality for configuring the network topology used by the Unified CCMP system. This tool enables configuration of servers, resources (for example, Unified CCMP components, Unified CCE components) and the connections between them. It also provides monitoring capabilities.

- **System Properties Manager**
  - Provides functionality for configuring system-wide properties that control a variety of Unified CCMP components.

- **Replication Manager**
  - Provides functionality for configuring and monitoring SQL Server replication between Unified CCMP databases.

- **Services Manager**
  - Provides functionality for monitoring and controlling all Unified CCMP services across servers from a single centralized location.

- **Failover Manager**
  - Provides functionality for performing manual switchover of the Data Import and Provisioning services between two servers.

- **Custom Dimension Editor**
  - Creates and edits custom dimensions.

- **Gadget Provider Manager**
  - Manages the Gadget Providers and Folder Mappings in the system. **This feature is not supported.**

ICE is installed as part of the Unified CCMP component installation.
Using ICE

Starting ICE

1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database Connection dialog box, set:
   - Server Name. Enter the name of the primary database server.
   - Database Name. Enter the name of the Unified CCMP database that was installed when setting up the Database Component. If you accepted the default value, this will be Portal.
2. Click OK. The ICE Cluster Configuration tool starts by default.
3. If there were errors or warnings in the configuration, then the error details are shown in the Cluster Configuration Error List pane (see section "Cluster Configuration Error List Pane").

Note
When ICE starts, the Error List pane shows both connection errors and validation errors. Subsequently, the Error List pane only shows validation errors. But the connection status can be seen at any time on the Connections page (see section "Connections Page").

ICE Menu and Toolbar

Common actions are visible in the menu and the tool bars at the top of the screen. The common actions supported by ICE are as follows:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Save</td>
<td>Save any changes.</td>
</tr>
<tr>
<td></td>
<td>Exit</td>
<td>Close the ICE application.</td>
</tr>
<tr>
<td></td>
<td>Preferences</td>
<td>View the ICE tool and component preferences.</td>
</tr>
<tr>
<td></td>
<td>View Output</td>
<td>View the standard output feedback window.</td>
</tr>
<tr>
<td></td>
<td>Undo</td>
<td>Undo the last change.</td>
</tr>
<tr>
<td></td>
<td>Redo</td>
<td>Redo the last change.</td>
</tr>
</tbody>
</table>
• Configured actions may be shown in the menu, the tool bar or both. Generally, commonly used actions (for example, Undo, Redo) are displayed in both the tool bar and the menu, and less commonly used actions just appear in the menu.

• As an example, consider the File action shown in Figure 1.1 "Common File Actions". Save and Open are shown on both the menu and tool bar, whereas Exit and Preferences are only shown in the menu. The ICE tool in this example is the System Properties tool.

![Figure 1.1 Common File Actions](image)

**ICE Tool Selection**

The ICE application toolbar contains a drop down list below the menu (see Figure 1.2 "ICE Tool Selection Drop Down List"). This contains the available ICE tools. To start an ICE tool, select it from the drop down list.
ICE Tool Area

The central area of the ICE application is used by each ICE tool for their own interface. Figure 1.3 "Central Pane for ICE System Properties Tool". shows the central pane for the ICE System Properties tool.
ICE Output Pane

The bottom area of the ICE application contains an output pane showing the output from the active ICE tools. This area also contains any additional output panes from specific ICE tools.

If both the ICE output pane and a specific output pane are available, they are shown one on top of the other, with a tab to select the one that is visible. Figure 1.4 "Output and Error Panes for ICE Cluster Configuration Tool" shows the ICE output pane and the error list pane from the ICE Cluster Configuration tool. In this example, the ICE output pane is currently visible.
Figure 1.4  Output and Error Panes for ICE Cluster Configuration Tool

You can control the display of the output panes in the following ways:

- You can change the height of the whole area by dragging the top edge up or down using the mouse.
- You can close the current pane, by clicking on the cross at the top right of the pane.
- You can show or hide any currently available pane from the View menu.

You can control the output that is shown in the ICE output pane as follows:

- Click on the **Show output from** drop down list at the top left of the pane to show output from one ICE tool or from all ICE tools. In the example in Figure 1.4 "Output and Error Panes for ICE Cluster Configuration Tool" the output pane is showing the output from the Cluster Configuration tool only.
- Click on the **Level** drop down list to choose the level of output you want to see. In the example in Figure 1.4 "Output and Error Panes for ICE Cluster Configuration Tool" the output pane is showing the information level output messages.
Cluster Configuration

About Cluster Configuration

Description
The Cluster Configuration tool enables you to configure the Unified CCMP and third party servers and components in an Unified CCMP deployment. It also enables you to define connections between these components and specify the connection credentials. The cluster configuration created using this tool provides individual Unified CCMP components with information about how to route data within the system.

The Cluster Configuration Model
The Cluster Configuration tool provides a graphical interface over a model that is used as part of the generic Unified CCMP monitoring component to test and provide connections to all services in the Unified CCMP platform.

The underlying cluster configuration model consists of the following core objects:

- Servers
  - A server represents a physical computer on the network.
- Physical Resource Components
  - A physical resource component represents a real service running on a server. For example a ConAPI service or AW Database on an ICM.
- Physical Resource
  - A physical resource is a grouping of physical resource components that all form part of the same system. For example a Unified CCE system may consist of an AW and a ConAPI component.
- Logical Resources
  - A logical resource is a grouping of several physical resources that represent replicated versions of a single system. For example a Unified CCE system may be dual-sided, consisting of two distinct systems for fault tolerance and redundancy. In this situation there would be a single logical Unified CCE resource with 2 physical resources instances, one representing side A and the other representing side B.
- Physical Connections
  - A physical connection represents a link between two physical resource components. The component being connected to is known as the destination component, and the component connecting is known as the source component.
The Cluster Configuration tool supports loading and saving this model from both an Unified CCMP database and an XML file.

**Equipment Mappings**

Equipment mappings define mappings between folders and remote equipment which specify where imported items are placed in the Unified CCMP folder tree. They also control the visibility of remote equipment and their resources in the user interface.

**Equipment Mappings and Importer Behavior**

The importer uses the equipment mappings to determine which folder to place new items in. The folder is chosen by applying the following logic, in order:

- If the item being imported is owned by a remote tenant and there is a corresponding equipment mapping for that remote tenant, the importer chooses the folder defined by the mapping.
- If the item being imported is owned by a remote tenant but there is no corresponding equipment mapping for that remote tenant, the importer chooses the default import location folder, if one is defined.
- Finally if there is no remote tenant mapping or default import location mapping specified, the importer chooses the /Unallocated folder within a subfolder named after the equipment, for example, /Unallocated/CICM123.

If an equipment mapping is changed after an initial import, the importer moves existing items to a new folder based on the logic above in the following scenarios:

- If an item is currently in the equipment’s /Unallocated folder.
- If an item’s location is no longer synchronized with its remote tenant ownership. See section "Importing Remote Ownership Changes" for details.

**Equipment Mappings and the User Interface**

Using a combination of a user’s security permissions and the equipment mappings, it can be determined which remote equipment the user has the right to access. This is applied when the equipment is listed in the Unified CCMP web application for example, on the person dimension edit screen and phone creation screen (Unified Communications Manager drop-down list).

The user has the right to view equipment if there is an equipment mapping to any tenant that contains any folder that the user has permission to view. For example, if there was a tenant: /t1 and the user had the right to see folder /t1/folder1 and there was an equipment mapping to /t1/folder2 then the user has right to view the equipment. The user also has the right to view equipment which only has equipment mappings to folders outside of tenants.

For more information on moving resources through the Unified CCMP web application please refer to the User Guide for Cisco Unified Contact Center Management Portal.
**Resource Ownership Principles**
Resources in Unified CCMP are owned by tenants. This section describes how this ownership is managed and the implications of item ownership on the importer.

**Unified CCMP Tenant Ownership**
Unified CCMP tenant folders contain the items which they own. Moving an item to another tenant folder automatically changes its owner. Items located outside the tenant folders are not owned by a specific tenant. Depending on the security settings, these items can be shared between tenants or hidden from all tenants.

**Default Domain Management**
Each time the Default Domain setting is changed using the System Info Tool in the Config Manager, the Unified CCMP ICE wizard must be manually executed to retrieve this information and store it against the Unified CCE Cluster Resource in the Unified CCMP database. Failure to do so causes Unified CCMP to become inconsistent with Unified CCE.

**Single Sign-On Management**
Each time the Single Sign-On (SSO) mode is updated in Unified CCE, it is not automatically updated in Unified CCMP. The Unified CCE wizard must be manually executed to retrieve this information and store it against the Unified CCE Cluster Resource in the Unified CCMP database. Failure to do so causes Unified CCMP to become inconsistent with Unified CCE and does not display the correct options for configuring Persons in Unified CCMP. SSO mode for Unified CCMP can be set to Disabled, Enabled, or Hybrid mode.

**Remote Tenant Ownership**
Some Unified CCE items also have an additional level of ownership on the Unified CCE instance. The Unified CCE equivalent of a tenant is a *customer definition*, which can be associated with the following items:
- dialed numbers
- call types
- labels
- network VRU scripts
- scheduled targets
- routing scripts.

These items are therefore capable of being owned by both an Unified CCMP tenant and a remote (Unified CCE) tenant.
Remote Tenant Mappings
Unified CCMP automatically determines which items belong to which remote tenant based on their location in the folder tree. An item which is located anywhere under a folder mapped to a remote tenant will be associated with and owned by that remote tenant.

The remote tenant mappings control two Unified CCMP behaviors:
- The folder that remote tenant owned items are placed in by the importer.
- How the remote tenant ownership changes when a remote tenant owned item is moved through Unified CCMP.

Remote tenants are mapped to folders from the Equipment Mappings page (see section "Equipment Mappings Page").

Changing the Ownership of an Item
An item’s ownership can be changed in any of the following ways:
- moving the item or the folder containing the item to a different Unified CCMP tenant.
- moving an item capable of being owned by a remote tenant to a folder located under a different remote tenant mapping.
- changing the remote tenant mapping of an item on the remote equipment (for example, Unified CCE).

Changing Ownership by Moving Items
Since the ownership of items is governed by where it is located in the folder tree, moving an item can result in a change of remote or Unified CCMP tenant ownership.

The ownership of an item is calculated from the closest remote tenant mapping above the item in the folder tree. If moving an item changes this mapping, the remote tenant ownership is updated and the change is provisioned to the remote equipment.

A change of remote tenant mapping during a move is not allowed if the item is referenced by a customer specific Unified CCE routing script or has a membership to any other items which also have a remote tenant mapping. For example, the user cannot move a label out of a folder which has a remote tenant mapping if it is referenced by a script which has a remote tenant association. To move the label, it must first be removed from the script or alternatively the script should be made visible to all customers using the Unified CCE Script Editor.

 Provisioning of scheduled targets is not supported, so any move which requires a change of remote tenant will not be allowed. Likewise if script provisioning is disabled for the Unified CCE, any move of a routing script that requires a change of remote tenant will not be allowed.

Items owned by remote tenants for which there are no remote tenant mappings will not have their remote ownership changed unless they are moved into a folder with a different remote tenant mapping.
**Importing Remote Ownership Changes**

The Data Import service ensures that any remote tenant owned items are correctly located in the folder tree according to the configured remote tenant mappings. If a remote tenant owned item has no corresponding remote tenant mapping, it will be placed in the default import location. If the remote tenant of an item is changed on the Unified CCE the importer will move the item according to the defined remote tenant mappings so that the item’s folder location continues to reflect the correct remote tenant ownership.

---

**Cluster Configuration Tool Reference**

**Cluster Configuration Actions**

The ICE Cluster Configuration tool supports the following ICE actions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save</td>
<td>Save any changes to the currently loaded configuration.</td>
</tr>
<tr>
<td><img src="image" alt="Undo" /></td>
<td>Undo</td>
<td>Undo the last change made to the configuration.</td>
</tr>
<tr>
<td><img src="image" alt="Redo" /></td>
<td>Redo</td>
<td>Redo the last change made to the configuration</td>
</tr>
</tbody>
</table>

The ICE Cluster Configuration tool also has the following additional actions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save As" /></td>
<td>Save As</td>
<td>Save the currently open configuration to a database</td>
</tr>
<tr>
<td><img src="image" alt="Save As Database" /></td>
<td>Save As Database</td>
<td>Save the currently open configuration to a database</td>
</tr>
<tr>
<td><img src="image" alt="Save As File" /></td>
<td>Save As File</td>
<td>Save the currently open configuration to an XML file</td>
</tr>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Refresh</td>
<td>Refresh the configuration from the current connection (database or file)</td>
</tr>
<tr>
<td><img src="image" alt="Validate" /></td>
<td>Validate</td>
<td>Validate the current configuration, and display any validation errors in the Error List pane. <strong>Note:</strong> Validate does not check connection errors, although the Error List pane does include connection errors at startup. If any connection errors were shown in the Error List pane, they will be cleared when you select Validate.</td>
</tr>
<tr>
<td>Icon</td>
<td>Action</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>![folder]</td>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>![folder]</td>
<td>Open Database</td>
<td>Open configuration from a database</td>
</tr>
<tr>
<td>![folder]</td>
<td>Open File</td>
<td>Open configuration from an XML file</td>
</tr>
<tr>
<td>![red-circle]</td>
<td>Create Checkpoint</td>
<td>Create a checkpoint in the current configuration. Allows all changes from a given point to be easily reverted.</td>
</tr>
<tr>
<td>![clock]</td>
<td>Revert To Last Checkpoint</td>
<td>Revert the state of the configuration to the last checkpoint, reverting and clearing all changes since the checkpoint.</td>
</tr>
</tbody>
</table>

**Cluster Configuration Preferences**

The ICE Cluster Configuration tool has the following additional preferences:

<table>
<thead>
<tr>
<th>Preference Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General: Advanced Mode</td>
<td>Indicates if the current user should be shown advanced properties on the cluster configuration objects within the user interface. This option is not required for day-to-day operations.</td>
</tr>
<tr>
<td>General: Connection Monitor Refresh Period</td>
<td>Indicates the rate in seconds at which the connection monitoring system will check the backing store for connection state changes. Default is 5 seconds.</td>
</tr>
</tbody>
</table>

The preferences configuration pane is shown in Figure 2.1 "Cluster Configuration General Preferences User Interface" below.


**Figure 2.1  Cluster Configuration General Preferences User Interface**

**Cluster Configuration Filters**

Some of the Cluster Configuration pages support a filter function to limit the number of items shown according to a user-specified filter. To access the filter, where available, click **Show Filter** ( ).

The actual filters that you can specify depend on the Cluster Configuration page. Within the filter area, click **Clear Filter** ( ) to clear any filters you have specified and click **Hide Filter** ( ) to hide the filter options.

The following Cluster Configuration pages support a filter:

- Servers page
- Connections page
- Resources page.

**Cluster Configuration User Interface**

When you run the Cluster Configuration tool for the first time you are automatically connected to a model using the shared Unified CCMP relational database connection. You are prompted for credentials to connect to the Unified CCMP relational database.
Once connected, you will see the initial screen shown in Figure 2.2 "Cluster Configuration Initial Interface”.

Figure 2.2 Cluster Configuration Initial Interface

On the left hand side of the main interface there is a navigation menu that allows easy switching between the various configuration pages within the tool. These configuration pages include:

- **Setup.** Contains high-level wizards that are designed to make day-to-day configuration changes quick and easy.
- **Servers.** Allows physical servers within the model to be added, removed or updated.
- **Resources.** Shows the logical resources, physical resources, and physical resource components configured within the model. These items can be added, removed, or updated here.
- **Equipment Mapping.** Only enabled when connected to an Unified CCMP database. Enables you to create tenants and folders in Unified CCMP and to map equipment like Unified CCE systems to folders for import and provisioning.
- **Connections.** Allows Unified CCMP component connections to be viewed and edited.
Cluster Configuration Error List Pane

The Cluster Configuration has an additional output pane, the Error List pane (see Figure 2.3 "The Cluster Configuration Error List Pane"). Click the Error List tab to view the errors and warnings from Cluster Configuration tool. You can click on the error details to see more information about an error.

Initially, this pane shows the connection errors and warnings (if any) and validation errors and warnings (if any) that were detected at start-up. Click Save or Validate to update the contents of the Error List pane with the current validation errors and warnings.

**Note**
When you click Save or Validate, any connection errors and warnings are cleared from the Error List pane. You can view connection problems at any time on the Connections page (see section "Connections Page").

You can click on the buttons at the top of the error pane to choose the type of error you want view. In the example in Figure 2.3 "The Cluster Configuration Error List Pane", errors and warnings have been selected for display, but messages have not been selected for display.

See section "ICE Output Pane" for general information about showing and hiding output panes.

![Cluster Configuration Error List Pane](image)

**Figure 2.3** The Cluster Configuration Error List Pane
Setup Page
For information about the Setup page in the Cluster Configuration tool, see the *Installation and Configuration Guide for Cisco Unified Contact Center Management Portal*, Unified CCMP Configuration chapter, Configuring the Unified CCMP Cluster section, Setting Up the Unified CCMP Servers subsection.

Servers Page
The Servers page within the Cluster Configuration tool enables physical servers within the Unified CCMP deployment to be added, removed or updated.

The Servers page is shown in Figure 2.4 "Cluster Configuration Servers Page".
The Servers page consists of a left and right pane. The left hand pane contains a list view displaying all of the servers configured in the open model. The right hand pane is a property grid that displays the details of the currently selected server within the list view.

- Server objects support the following properties:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Address</td>
<td>✔</td>
<td>The default address that will be used when services within the Unified CCMP deployment connect to this server. This may be a host name or IP address.</td>
</tr>
<tr>
<td>Display Name</td>
<td>✔</td>
<td>A name used to represent this object when it is referred to in logs, performance counters etc.</td>
</tr>
<tr>
<td>Property Name</td>
<td>Advanced</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Enabled</td>
<td></td>
<td>Indicates if this server is enabled. This is a calculated field and actually indicates whether all physical resource components on this server are enabled. Changing this value will update the enabled flag of all physical resource components on this server.</td>
</tr>
<tr>
<td>Id</td>
<td>✓</td>
<td>A unique ID used to represent this object on the backing store.</td>
</tr>
<tr>
<td>Server Name</td>
<td></td>
<td>The machine name for this server. This is used to identify an Unified CCMP service’s machine within the cluster model and should match the value returned by SQL server using @@SERVERNAME or SYSTEMPROPERTY ('MachineName'). Viewing Computer properties on a Windows based computer and looking at the “Computer Name” property can typically find the correct value.</td>
</tr>
<tr>
<td>System</td>
<td>✓</td>
<td>Indicates if the Unified CCMP system installers created this object.</td>
</tr>
</tbody>
</table>

Click **Add New** within the list view to add a new server to the model. Clicking this will automatically create a new server in the model and select it ready for editing.

- Right-click in the Servers page to see a shortcut menu with the following functions:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>Add Server</td>
<td>Add a new server to the model.</td>
</tr>
<tr>
<td>✗</td>
<td>Remove Server</td>
<td>Remove the selected server from the model.</td>
</tr>
<tr>
<td></td>
<td>View</td>
<td>Change the display style of the list view.</td>
</tr>
</tbody>
</table>

The Servers page includes a filter which enables you to filter by server name or address. Click **Show Filter** ( ) to expand the filter area if it is not currently shown.

---

**Resources Page**

The Resources page within the Cluster Configuration tool enables logical resources, physical resources, and physical resource components within the model to be added, removed or edited.
The Resources page consists of a left and right pane, very similar to the layout of the Servers page. The left hand pane contains a list view displaying all of the logical and physical resources configured in the open model. The right hand pane is a property grid that displays the details of the currently selected object within the list view.

The Resources page includes a filter which enables you to filter by resource group type, resource type, server or resource name. Click Show Filter ( ) to expand the filter area if it is not currently shown.

The list view on the Resource page contains multiple groups. Each group represents an individual logical resource within the model. Within each group there will be one or more items, each representing a physical resource within that logical resource. This structure is highlighted in Figure 2.6 "Example Logical Resource List View Group".
Logical Resources

You can select an logical resource by clicking on the group header text (for example, the text: Provisioning Server [Provisioning Service] (2) in the example of Figure 2.6 "Example Logical Resource List View Group"). Selecting a logical resource displays its properties in the property grid pane, as shown in Figure 2.7 "Property Grid View for Logical Resource".

The property grid for a logical resource has two tabbed sections; General and Specific. The General tab contains properties that are common to several logical resources. The Specific tab contains properties that relate to the specific type of logical resource that has been selected.

Properties of Logical Resources

Logical resource objects may support the following basic properties (through the General tab):
<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cache Enabled Resource Types</td>
<td></td>
<td>The resource types that will be cached by this server to enhance performance (applies to App/Web server only).</td>
</tr>
<tr>
<td>Child Resources</td>
<td></td>
<td>The logical resources in the system that are children of this resource.</td>
</tr>
<tr>
<td>Default Import Enabled Resource Types</td>
<td></td>
<td>The resource types that will be imported by default. This can be overridden on a specific item of remote equipment if required (applies to Data Import Server only).</td>
</tr>
<tr>
<td>Description</td>
<td></td>
<td>A short description of the logical resource.</td>
</tr>
<tr>
<td>Display Name</td>
<td>✓</td>
<td>A name used to represent this object when it is referred to in logs, performance counters etc. (Read-only)</td>
</tr>
<tr>
<td>Enabled</td>
<td></td>
<td>Indicates if this logical resource is enabled. This is a calculated field and actually indicates whether all physical resources in this logical resource are enabled. Changing this value will update the enabled flag of all physical resources in this logical resource.</td>
</tr>
<tr>
<td>Id</td>
<td>✓</td>
<td>A unique ID used to represent this object on the backing store. Read only.</td>
</tr>
<tr>
<td>Import Enabled Resource Types</td>
<td></td>
<td>The resource types that will be imported from this item of remote equipment (applies to remote equipment objects only). The settings here override the settings in Default Import Enabled Resource Types. When a default setting is overridden for a resource type, that resource type is shown in bold.</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td>A unique name for this logical resource.</td>
</tr>
<tr>
<td>Parent Resources</td>
<td></td>
<td>The logical resources in the system that may be considered to be parents of this resource.</td>
</tr>
<tr>
<td>Provisionable</td>
<td></td>
<td>Whether provisioning has been enabled for this logical resource (applies to remote equipment only). Must not be enabled/checked for PCCE systems as Resource Management is not supported for PCCE</td>
</tr>
<tr>
<td>System</td>
<td>✓</td>
<td>Whether this object was created by the system installers. Read only.</td>
</tr>
<tr>
<td>Version</td>
<td>✓</td>
<td>The source system version for this logical resource.</td>
</tr>
</tbody>
</table>

The derived logical resource properties for the standard built in resource types are as follows:
## Cisco CICM

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active Directory Path</td>
<td></td>
<td>The active directory location from which users can be selected to provide supervisors with WebView login credentials. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Deployment Type</td>
<td></td>
<td>The deployment type for this CICM.</td>
</tr>
<tr>
<td>Domain Password</td>
<td></td>
<td>The password to use when connecting to active directory if &quot;Secure Authentication&quot; has been specified. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Domain User Name</td>
<td></td>
<td>The user to impersonate when connecting to active directory if &quot;Secure Authentication&quot; has been specified. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Last Dimension Import Config Change Date</td>
<td>✓</td>
<td>The value of the ControllerConfigChangeTime field in the AWControl table on the AW the last time a dimension import ran for this resource. (Read-only)</td>
</tr>
<tr>
<td>Last Member Import Config Change Date</td>
<td>✓</td>
<td>The value of the ControllerConfigChangeTime field in the AWControl table on the AW the last time a member import ran for this resource. (Read-only)</td>
</tr>
<tr>
<td>Multi Media Enabled</td>
<td></td>
<td>Indicates if multimedia reskilling is supported for this CICM. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Person Minimum Password Length</td>
<td></td>
<td>The minimum password length configured for this CICM. (Read-only)</td>
</tr>
<tr>
<td>Primary Domain Server</td>
<td></td>
<td>Primary domain server for active directory access. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Purge Items on Delete</td>
<td></td>
<td>Indicates if items should be automatically purged on delete (or only marked for delete) on ICM. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Script Lock User Name</td>
<td></td>
<td>User name for use when locking routing scripts for edit. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Script Provisioning Enabled</td>
<td></td>
<td>Indicates if script provisioning is enabled for this ConAPI resource. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Secondary Domain Server</td>
<td></td>
<td>Secondary domain server for active directory access. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Property Name</td>
<td>Advanced</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Secure Authentication</td>
<td></td>
<td>Indicates whether a specific user should be impersonated when contacting to active directory. (Only shown if a ConAPI component is configured for the physical resource)</td>
</tr>
<tr>
<td>Time Zone</td>
<td></td>
<td>The timezone for the ICM.</td>
</tr>
<tr>
<td>Time Zone Display Name</td>
<td></td>
<td>Display name for the ICM timezone. (Read-only)</td>
</tr>
</tbody>
</table>

**Data Import Server Service**

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Cycle Delay</td>
<td>✓</td>
<td>The minimum delay between import cycles (in minutes).</td>
</tr>
</tbody>
</table>

**Physical Resources**

You can select an individual physical resource by clicking on physical resource in the list view (for example, the text: Provisioning Server 2 in the example of Figure 2.6 "Example Logical Resource List View Group"). Selecting a physical resource displays its properties in the right hand property grid pane, as shown in Figure 2.8 "Property Grid View for Physical Resource".

![Property Grid View for Physical Resource](image)

Figure 2.8 Property Grid View for Physical Resource
The property grid for a physical resource is broken into three tabbed sections; General, Specific, and Components. The General tab contains properties that are common to all physical resources. The Specific tab contains properties that relate to the specific type of physical resource that has been selected. The Components tab displays details for each of the physical resource components associated with the currently selected physical resource.

Properties of Physical Resource Objects

Physical resource objects support the following basic properties (through the General tab):

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DisplayName</td>
<td>✓</td>
<td>A name used to represent this object when it is referred to in logs, performance counters etc. (Read-only)</td>
</tr>
<tr>
<td>Enabled</td>
<td></td>
<td>Indicates if this physical resource is enabled. This is a calculated field and actually indicates whether all physical resource components in this physical resource are enabled. Changing this value will update the enabled flag of all physical resource components in this physical resource.</td>
</tr>
<tr>
<td>Id</td>
<td>✓</td>
<td>A unique ID used to represent this object on the backing store. (Read-only)</td>
</tr>
<tr>
<td>Is Publisher</td>
<td></td>
<td>Indicates if this physical resource is considered a publisher for replication within the logical resource.</td>
</tr>
<tr>
<td>Name</td>
<td></td>
<td>A unique name for this physical resource.</td>
</tr>
<tr>
<td>System</td>
<td>✓</td>
<td>Indicates whether this object was created by the system installers (read-only).</td>
</tr>
</tbody>
</table>

Derived, resource type specific properties are exposed through the Specific tab of the property grid. The derived physical resource properties for the standard built in resource types are as follows:

Application Server Service

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification Enabled</td>
<td></td>
<td>Indicates if this application server is responsible for raising resource notification events.</td>
</tr>
</tbody>
</table>
Data Import Server Service

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Import End</td>
<td>✓</td>
<td>The time when the last dimension import cycle ended. (Read-only)</td>
</tr>
<tr>
<td>Last Import Exception Count</td>
<td>✓</td>
<td>The number of errors that occurred on the last import cycle. (Read-only)</td>
</tr>
<tr>
<td>Last Import Start</td>
<td>✓</td>
<td>The time when the last dimension import cycle started. (Read-only)</td>
</tr>
<tr>
<td>Last Import Type</td>
<td>✓</td>
<td>The type of the last import cycle. (Read-only)</td>
</tr>
</tbody>
</table>

Relational Database

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix Management Enabled</td>
<td></td>
<td>Whether this database server is responsible for running the prefix management scheduled job.</td>
</tr>
<tr>
<td>Purge Enabled</td>
<td></td>
<td>Whether this database server is responsible for running the purge scheduled job.</td>
</tr>
<tr>
<td>Scheduling Enabled</td>
<td></td>
<td>Unused.</td>
</tr>
</tbody>
</table>

The Components tab on the property grid displays the properties for all physical resource components that belong to the selected physical resource.

The following table lists the component types supported and required for each of the built-in physical resource types:

<table>
<thead>
<tr>
<th>Physical Resource Type</th>
<th>Component Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Server</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Cisco Call Manager</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Cisco CICM</td>
<td>AWS</td>
<td>✓</td>
<td>The Admin Workstation component. Used for dimension/member import.</td>
</tr>
<tr>
<td></td>
<td>ConAPI</td>
<td></td>
<td>The Cisco ConAPI server. Used for provisioning changes to CCE.</td>
</tr>
<tr>
<td>Cisco CVP Call Server</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>
### Physical Resource Components

All physical resource components support the following properties:

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>✓</td>
<td>Application name used for this component when it is the source of a SQL connection. Can be used to identifier this resource in a SQL profile. (Read-only)</td>
</tr>
<tr>
<td>Display Name</td>
<td>✓</td>
<td>A name used to represent this object when it is referred to in logs, performance counters etc. (Read-only)</td>
</tr>
<tr>
<td>Id</td>
<td>✓</td>
<td>A unique ID used to represent this object on the backing store. (Read-only)</td>
</tr>
<tr>
<td>Inbound Connections</td>
<td></td>
<td>All connections to this component from other systems.</td>
</tr>
<tr>
<td>Outbound Connections</td>
<td></td>
<td>All connections from this component to other systems.</td>
</tr>
<tr>
<td>Server</td>
<td></td>
<td>The server on which this component resides.</td>
</tr>
<tr>
<td>System</td>
<td></td>
<td>Indicates whether this object was created by the system installers. (Read-only)</td>
</tr>
</tbody>
</table>

In addition, the following derived properties are supported:

<table>
<thead>
<tr>
<th>Physical Resource Type</th>
<th>Component Type</th>
<th>Required</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Import Server Service</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Partitioning Service</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Provisioning Service</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Relational Database</td>
<td>Default</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>
### Cisco CICM: AWS

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td></td>
<td>The database catalog name.</td>
</tr>
<tr>
<td>Custom Connection Test</td>
<td>✔️</td>
<td>SQL query containing custom connection test logic for this component.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The query should return a single row with a BIT column indicating the state of the component.</td>
</tr>
</tbody>
</table>

### Provisioning Service: Default

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Additional Java Virtual Machine Options</td>
<td></td>
<td>All additional options that should be passed to the hosted Java Virtual Machine. The -xrS option will be automatically passed in and does not need to be specified here.</td>
</tr>
<tr>
<td>Java Debug Port Number</td>
<td></td>
<td>The port number to use for connecting the remote debugger when Java debugging is enabled.</td>
</tr>
<tr>
<td>Java Debugging Enabled</td>
<td></td>
<td>Enable or disable debugging support in the hosted Java Virtual Machine.</td>
</tr>
<tr>
<td>Java RMI Server Hostname</td>
<td></td>
<td>The value of this property represents the host name string that should be associated with remote stubs for locally created remote objects, in order to allow clients to invoke methods on the remote object.</td>
</tr>
</tbody>
</table>

### Relational Database: Default

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Advanced</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td></td>
<td>The database catalog name.</td>
</tr>
<tr>
<td>Custom Connection Test</td>
<td>✔️</td>
<td>SQL query containing custom connection test logic for this component.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The query should return a single row with a BIT column indicating the state of the component.</td>
</tr>
</tbody>
</table>

Logical resources, physical resources and physical resource components may be added/removed from the model via a context menu that can be accessed by right-clicking on the main list view area.
Connections

Connections can be created between two physical resource components within the cluster configuration model. Components may support inbound connections (that is, other components may connect to them), outbound connections (that is, they can connect to other components) or both inbound and outbound connections. Each physical resource component type has a connection type associated with it that defines how other components should connect with it.

Unified CCMP supports the following connection types:

<table>
<thead>
<tr>
<th>Connection Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cisco ConAPI</td>
<td>Provides support for connections to a Cisco CMS JServer using the ConAPI Java RMI layer.</td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td>Provides support for connections to a Microsoft SQL Server database.</td>
</tr>
</tbody>
</table>

Connections can be added, removed or updated by clicking on the “Inbound Connections” or “Outbound Connections” property on a component entry in the property grid. To edit connections from the selected component to other components use the “Outbound Connections” property. To edit connections to the selected component from other components use the “Inbound Connections” property. These properties are only visible on components where connections are supported.

For example, to edit outbound connections for a provisioning server:

1. In the list view, select the required provisioning server.
2. In the property grid pane, click on the Components tab.
3. Click on the Outbound Connections property (see Figure 2.9 "Example Connection Editing").

![Figure 2.9 Example Connection Editing](image-url)
4. Click on the ellipsis beside the Outbound Connections property. This displays the Manage Outbound Connections From dialog box, as shown in Figure 2.10 "Manage Outbound Connections Dialog Box".

![Manage Outbound Connections Dialog Box](image)

**Figure 2.10  Manage Outbound Connections Dialog Box**

The Manage Outbound Connections dialog box has two main panes. The left hand pane contains a tree view showing all the components that are available to connect to or from. The tree view groups all the available components by physical component type and logical resource. An example of this is shown in Figure 2.11 "Connection Edit Dialog Tree View".
When a connection exists to a component instance, the icon on the component is highlighted in green. When no connection exists, the icon is grayed out.

Within each logical resource grouping, the component instances in the logical resource are listed in order of cost. The cost of a connection is an indication of the resources it has available to it and how well it will perform – connections with a lower cost can be expected to perform better than connections with a higher cost. For example, it may be more efficient to make a connection to a server that is co-located with the server requesting the connection than to make a connection to a server in another country. In this case, you would define the local server as having a lower cost than the server in another country.

Unified CCMP will use the lower cost connection if it is available. For example, if a Provisioning server was connected to a dual sided database then one of the two sides would be the preferred (lowest cost) connection and the other would be the redundant (highest cost) connection.

To change the relative cost of connections, select a component in the tree view and click the up or down arrow at the bottom right of the pane to reduce or increase the cost, as shown in Figure 2.12 "Changing the Relative Cost of Connections".

**Figure 2.11 Connection Edit Dialog Tree View**

When a connection exists to a component instance, the icon on the component is highlighted in green. When no connection exists, the icon is grayed out.

Within each logical resource grouping, the component instances in the logical resource are listed in order of cost. The cost of a connection is an indication of the resources it has available to it and how well it will perform – connections with a lower cost can be expected to perform better than connections with a higher cost. For example, it may be more efficient to make a connection to a server that is co-located with the server requesting the connection than to make a connection to a server in another country. In this case, you would define the local server as having a lower cost than the server in another country.

Unified CCMP will use the lower cost connection if it is available. For example, if a Provisioning server was connected to a dual sided database then one of the two sides would be the preferred (lowest cost) connection and the other would be the redundant (highest cost) connection.

To change the relative cost of connections, select a component in the tree view and click the up or down arrow at the bottom right of the pane to reduce or increase the cost, as shown in Figure 2.12 "Changing the Relative Cost of Connections".
Figure 2.12  Changing the Relative Cost of Connections

When a component is selected in the tree view, the right hand pane will automatically populate with the details for the connection. The connection details pane is broken into three sections; a common header, a connection type specific properties page and a generic footer. An example for a SQL connection is shown in Figure 2.13 "Connection Details Pane".
The common header consists of the following:

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected</td>
<td>Indicates if a connection exists to the selected component. Checking this box creates a connection. Clearing this box deletes the connection.</td>
</tr>
<tr>
<td>Enabled</td>
<td>Indicates if this connection is enabled. Disabled connections will not be used by the Unified CCMP monitoring service.</td>
</tr>
<tr>
<td>Override Default Server</td>
<td>By default, the host name for the server on which component resides will be selected from the server objects Default Address property. However, there may be situations where the actual host name used for a specific connection between two components needs to be altered (for example when using network address translation). In these situations, the host name can be set by checking the Override Default Server box and entering the new host name in the Address field.</td>
</tr>
</tbody>
</table>

The middle pane contains connection type specific properties. For example, when editing a SQL connection this pane contains settings for the authentication mode and database catalog etc.

The common footer contains a single Test button. Clicking this button will test the connection using the details provided in the details section.
Connections are tested within the context of the ICE application so tests may provide inaccurate results. When the connections are used by the Unified CCMP system they will be created on remote servers and subject to any firewalls, network address translation or environment issues that may exist on those servers. The connections will also be established using the windows credentials of the service rather than the credentials being used to run the ICE application.

Equipment Mappings Page

The Equipment Mapping tab of the ICE Cluster Configuration tool enables you to create Unified CCMP tenants and folders, and to specify the way that resources on the contact center are mapped to Unified CCMP.

The Equipment Mappings page is divided into three vertical sections.

- Folder Tree section
- Source Equipment section (shown when an item is selected in the folder tree)
- Association Options section (shown when an item is ticked and highlighted in the source equipment section).

To configure your equipment mapping, in the Cluster Configuration tool, select Equipment Mapping in the left hand navigation pane.

Folder Tree Section

This section enables you to create new tenants and folders in the Unified CCMP Folder Structure. To create a new tenant or a folder, right-click on the location in the tree where you would like to create the item and select Add Tenant or Add Folder.

Note

Tenants can only be created under the root folder. Folders can be created anywhere in the tree. A Tenant is a special folder that maintains ownership of an item. For example, in a hosted environment, the host’s customers map directly to individual tenants, each of which is assigned their own individual resources, for example, Agents, Teams, Call Types etc.

Right-clicking and selecting the Refresh option refreshes the folder structure from the database, reflecting any changes that may have been made through the Unified CCMP web application.

Right-clicking and selecting the Properties option displays a window in which an Azure AD directory ID can be mapped to the tenant to allow the use of company credentials to authenticate if synchronized with Azure. For more information about setting up Azure AD authentication, see Installation and Configuration Guide for Cisco Unified Contact Center Management Portal.
Source Equipment Section
This section lists all the configured source equipment. If none are configured then this list will be empty and you will not be able to do any associations.

When you select one of the items of configured equipment in the list, you will see options to map the resources belonging to that equipment to the selected folder in the Association Options Section.

Association Options Section
This section offers a list of association options between the folder or tenant in the folder tree and the source equipment. There are two types of association options.

- **Default Import Location.** All resources from the highlighted contact center equipment will be imported into the selected folder or tenant in Unified CCMP.

- **Customer Resource Mapping.** Allows more control over the import process. You can specify the items on the highlighted contact center equipment to be placed in the selected folder or tenant in Unified CCMP. If you select this option you can:
  - Click + to add a new customer resource mapping that defines the resource types and the specific resources of that type to be mapped to the selected import location. Select the resource type from the Type drop-down list (one of Peripheral, Routing Client, Media Routing Domain and Remote Tenant) then select the specific item of that type that you want to map from the Resource drop-down list. Click OK. Repeat to map other customer resources on this item of contact center equipment to the specified import location.

Note
Multiple Global Catalogs for different customer definition mapping should not be configured if a default domain for Unified CCE has been configured. Global Catalog mapping overrides the default domain configuration, which then requires that full valid values for UPN or SAM format must be provided when saving supervisor agents. For more information about default domains and how to configure supervisor agents, see User Guide for Cisco Unified Contact Center Management Portal.

- Click ✗ to delete an existing customer resource mapping.

If **Customer Resource Mapping** is selected then any resources on the contact center equipment that are not associated with the selected mapping will be placed in the source equipment subfolder under the Unallocated folder.

Note
If you want to use the customer resource mapping option, you will not be able to configure this until you have imported the customer resources you want to use to define the mappings.
In this case, for the first import, **do not** select the Default Import Location option, as once you have selected this, the items from the remote equipment will be imported to that location and cannot be re-imported. Instead, for the first import, **do not specify any import location**, so everything is imported into the `/Unallocated` folder. Once the customer resources have been imported, you can specify the customer resource mapping you require, and the items in the `/Unallocated` folder will be moved to the required locations.

**Note**
The Customer Resource Mapping is currently only valid for Cisco Unified CCE Resources. The list is populated with all the customer definitions available on the selected Cisco Unified CCE resource.

When you have completed your changes to equipment mappings, click the **Save** icon in the toolbar to save your changes.

### Connections Page

The Connections page within the Cluster Configuration tool enables all configured connections in the system to be edited and monitored.

The Connections page is shown in Figure 2.14 "Cluster Configuration Connections Page".
The Connections page consists of a resizable top and bottom pane. The top pane is the connection status monitor and shows the status of all the connections configured in the open model. The bottom pane displays the details for the currently selected connection in the list view.

Each row in the connection status monitor has the following columns:

<table>
<thead>
<tr>
<th>Column</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>An icon representing the status of the connection. The following options exist:</td>
</tr>
<tr>
<td></td>
<td>Available</td>
</tr>
<tr>
<td></td>
<td>Unavailable</td>
</tr>
<tr>
<td></td>
<td>Disabled</td>
</tr>
<tr>
<td>Source Server</td>
<td>The name of the physical server that this connection is being established from.</td>
</tr>
<tr>
<td>Column</td>
<td>Meaning</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Source Component Type</td>
<td>The display name for the physical resource component type that this connection is being established from.</td>
</tr>
<tr>
<td>Destination Server</td>
<td>The name of the physical server that this connection is being established to.</td>
</tr>
<tr>
<td>Destination Component Type</td>
<td>The display name for the physical resource component type that this connection is being established to.</td>
</tr>
</tbody>
</table>

Click the column headers in the connection status grid to sort the view by the selected column. Click on an entry in the grid (a source or destination server, or a source or destination component type) to go to the details for that item.

The row headers on the connection status grid may optionally show an alert icon (_notice) if there is a potential problem with the connection. Hovering over the alert icon will display a tool tip explaining the reason for the alert. The most common cause of an alert being displayed is to indicate that the connection status has not been updated for more than 5 minutes. This usually indicates that the source service is not running or is failing to connect with the Unified CCMP database. The source service log files should be used to investigate the cause of the problem.

To show the server details for a particular connection, hold down **Ctrl** and click on the connection.

To maximize the status monitor and show the Details and History tabs, click on the expand icon on the splitter bar (see Figure 2.15 "Connection Monitor Full Screen Mode").
Connection status is automatically refreshed from the database. By default, the status is refreshed every 5 seconds but this can be modified via the Cluster Configuration preferences (see section "Cluster Configuration Preferences").

The Connections page includes a filter which enables you to filter by resource type, component type, and server, for both the connection source and the connection destination. Click Show Filter ( ) to expand the filter area if it is not currently shown.

**Figure 2.15  Connection Monitor Full Screen Mode**

Diagnostic Portal Support

The ICE Cluster Configuration tool enables you to access the diagnostic portal and view diagnostic logs for the Unified CVP, Unified CCE, and Unified CCMP servers.

To view the logs for a server:
- configure the diagnostic portal for the server (you only need to do this once)
- select the required log and logging period to access the required logs.

**Configuring the Diagnostic Portal**

To configure the diagnostic portal for a server:
1. On the server you want to configure, identify a user name and password for an authorized user of the Diagnostic Framework. This user must be a trusted domain user in the CONFIG domain security group of the server being configured.

2. In the ICE Cluster Configuration tool, select the Resources tab.

3. Click on the server for which you want to configure the diagnostic portal.

4. In the right hand pane, select the Components tab.

5. Set the Diagnostic Portal User Name and Diagnostic Portal Password fields to the user name and password of the authorized user you identified above.

6. Select File > Save or click the Save icon in the toolbar.

**Note**

**Accessing the Diagnostic Logs**

To access a diagnostic log:

1. Right click on the server instance and from the context menu, select Components, then the component, then one of:
   - View Logs to view the logs
   - View Trace Logs to view the trace logs.

2. The Diagnostic Logs window is shown. In the Diagnostic Logs window, select the type of log you want to view from the drop down list in the top left of the window.

3. Specify the From Date and To Date to filter the results by a date range, then click Fetch Result to get a list of all available logs of that type within the selected date range.

4. The bottom left pane may show the logs that match the filter, or may show servers or folders containing logs that match the filter. Double click on the server or folder to view the contents of that item and drill down to the log files. When you locate the log file you want to view, double click on the log file to view the contents in the Raw Data tab of the right hand pane. For CSV log files, you can also select the CSV tab of the right hand pane to view the log file in CSV format.

**Note**
To view diagnostic logs, you must previously have configured the diagnostic portal for this server as described above.
Replication Manager

About Replication Manager

The Unified CCMP Replication Manager enables you to manage SQL Server Replication between Unified CCMP databases.

The Replication Manager has two modes:

- **Setup**: Used to configure and disable SQL Server replication between the Unified CCMP databases.
- **Monitor**: Used to monitor general health of configured replication, at to start and stop replication agents.

The Replication Manger should typically be run on the Unified CCMP database publisher (side A) server. The user running the tool must be a Windows administrator on all the servers that take part in replication.

**Note**
To use the Replication Manager, the Unified CCMP database must be configured as dual sided.

The Replication Manager Setup Tab

About the Replication Manager Setup Tab

The Replication Manager Setup tab enables you to configure or disable SQL Server Replication. It shows the configured Unified CCMP primary database and the distributor server properties.

The initial configuration is derived from the values set in ICE Cluster Configuration. If any of the values are modified, the configuration must be saved before replication setup can continue.

Unified CCMP Database Server Properties

This section shows the publisher and subscriber Unified CCMP databases. The following information is available:

- **Publisher**: The publisher database.
  - **Server Name**: The name of the Database Server. This is fixed and cannot be changed using the ICE Replication Manager.
• **Catalog Name.** The name of the Unified CCMP database. It is recommended that the default value is used, but if the name is modified, then an Unified CCMP database with the new name must already exist on the corresponding database server.

• **Subscriber.** The subscriber database.

• **Server Name.** The name of the Database Server. This is fixed and cannot be changed using the ICE Replication Manager.

• **Catalog Name.** The name of the Unified CCMP database. It is recommended that the default value is used, but if the name is modified, then an Unified CCMP database with the new name must already exist on the corresponding database server.

**Distributor Properties**

This section shows the SQL Server Replication distributor properties. By default the distributor is created on the subscriber Unified CCMP Database Server. In most cases the default values are valid and should be used.

The following information is available:

• **Server Name.** The name of the subscriber server hosting the database as configured using ICE Cluster Configuration.

• **Catalog Name.** The name to be assigned to the distribution database. The recommended default is *distribution_portal*.

• **Override Distributor Admin Password.** Select to override the auto-generated replication password which will be used to establish connectivity. The auto-generated password is 14 characters long, and will contain alpha-numeric characters (both upper and lower case) and a special character. If this does not meet the complexity requirements of the server then select this option and specify a password of your choice.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>This password is a one-off password used to set up replication. It is not stored and does not need to be recorded by the user.</td>
</tr>
</tbody>
</table>

• **Data Folder.** The folder path on the distributor server where the data file for the distribution database will be created.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you are setting up replication after performing an upgrade, be particularly careful with the Data Folder path, as it may be different from the value used in previous versions. Make sure you use the path that was specified when the database was set up.</td>
</tr>
</tbody>
</table>

• **Log Folder.** The folder path on the distributor server where the transaction log file for the distribution database will be created.
• **Distribution Share.** The distribution share folder where replication snapshot files will be generated.

---

**The Replication Manager Monitor Tab**

**About the Replication Manager Monitor Tab**

The Monitor tab shows the replication status and information about the data that is being copied from the publisher to the subscriber. It enables you to monitor the general health of the replication. It can also be used to start and stop various replication agents.

**Monitor Panes**

The Monitor tab contains four panes:

- **Publications** (top left) lists the publisher servers and the publications on each publisher that need to be shared with the subscribers.

- **Subscriptions and Agents** (top right) shows the subscriptions to a publication and the replication agents associated with a publication. This pane has two tabs:
  - **Subscriptions** shows the subscriptions to the selected publication. Right-click on a subscription to start or stop the subscription.
  - **Agents** shows the replication agents associated with the selected publication. Right-click on a replication agent to start or stop the agent.

- **Sessions** (bottom left) shows all sessions for the selected publication and replication agent in the last 24 hours.

- **Actions** (bottom right) shows the activity for the selected session. The status icons are:
  - Unknown
  - Running
  - Completed
  - Retry
  - Error

The information in the Monitor tab is refreshed every five seconds.
Using Replication Manager

Starting Replication Manager
To start Replication Manager:

1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database Connection dialog box, set:
   - **Server Name.** Enter the name of the primary database server.
   - **Database Name.** Enter the name of the Unified CCMP database that was installed when setting up the Database Component. If you accepted the default value, this will be Portal.
   - **Authentication.** Select Windows Authentication.
2. Click OK. The ICE Cluster Configuration tool starts by default.
3. In the Tools drop-down, select Replication Management. The Replication Manager tool is displayed:
   - If SQL Server replication is not currently configured, the Replication Manager tool starts in the Setup tab (see section "The Replication Manager Setup Tab").
   - If SQL Server replication is configured, the Replication Manager tool starts in the Monitor tab (see section "The Replication Manager Monitor Tab").

Configuring Replication
To configure replication if replication is not running, in Replication Manager, select the Setup tab and click Configure. This process may take several minutes. Once replication has been configured, the Replication Manager automatically switches to the Monitor tab, which enables you to monitor the replication process.

Disabling Replication
To disable replication if replication is currently running, in Replication Manager, select the Setup tab and click Disable. This may take several minutes. When replication has been disabled, a confirmation message is displayed.

Monitoring Replication
To monitor replication for a publication, in Replication Manager, select the Monitor tab and select a publication in the top left pane. The subscriptions and replication agents associated with the selected publication are listed in the top right pane in the respective tab.
The **Subscriptions** tab shows all the subscriptions to the selected publication. It will help answer the following questions:

- **Which subscriptions are slow?**
  
  This will show the latency of replication from publisher to the subscriber.

- **Is the replication system healthy?**
  
  The grid will show status icons for warnings and error for subscriptions that require attention.

The **Agents** tab displays the agents that are used by the selected publication. This tab shows the following agents:

- The **Snapshot Agent** is shown for all publications.
- The **Log Reader Agent** is shown for transactional publications Base and NonQueued.
- The **Queue Reader Agent** is shown for transactional publication Base only.

You can use the Monitor tab to start and stop the Subscriptions and Replication Agents. In order to start or stop, right-click on the selected subscription or agent and select **Start** or **Stop**.

You can view the session details for a Subscription or an Agent in the two bottom panes. Select the Subscription or Agent in the top right pane. The bottom left pane shows all the sessions for the selected Subscription or Agent in the last 24 hours. It shows the following details for each session:

- **Status** - the current status of the session.
- **Start Time** - when the session was started.
- **End Time** - when the session stopped. This is set only for sessions that are not currently running.
- **Duration** - the total duration for each session.

The bottom right pane shows the SQL Server Replication actions performed for a replication session. To see the actions for a replication session, select the replication session in the bottom left pane.

**Identifying Replication Errors**

The Monitor helps to identify replication errors that have occurred in replication. If an error has occurred in a particular subscription or an agent, the respective subscription or agent status icon will show an error.

Select the subscription or agent that shows the error. Selecting the subscription or agent will show their sessions. If an error occurred during a session, the session will show an error icon. Select the session with the error to see the actions. The actions describes the nature of the error in the action message.
More about Replication

Performance Considerations

Each time the information in the Monitor tab refreshes, it requests data from the underlying replication system. These additional requests may sometimes affect the overall performance of SQL Server Replication, especially on busy systems. As a result it is recommended that the Monitor should not be left running for long periods of time.
Failover Manager

About Failover Manager
The Unified CCMP Failover Manager enables you to manually switch the Provisioning and Data Import services between two fully operational servers in a dual-sided Unified CCMP installation.

Caution!
Only use the Unified CCMP Failover Manager to perform a planned manual failover, for example to perform maintenance on one of the servers. The service to be switched must be running and fully operational on both servers, and the data must have previously been synchronized between the servers.
Do not use the Failover Manager to switch between servers in a disaster recovery scenario, for example if one of the servers has failed or has corrupt data. If in doubt, please contact your vendor support before continuing.

Using Failover Manager

Preparing to Use the Failover Manager
Before performing a failover for a service:

- Be aware that the service will be unavailable during the failover, and that for a large database, the failover may take a significant period of time.
- Ensure that you have an up-to-date database backup.
- Ensure that you are logged in as a domain level user who has administrative rights on both servers, and also on the machine being used to run the ICE tool.
- Ensure that the firewalls on both servers and on the machine being used to run the ICE tool are configured as in the Network and Environment Configuration section of the Installation and Configuration Guide for Cisco Unified Contact Center Management Portal.

Warning
Before a failover is attempted, Replication Manager must be checked. Failover can only happen successfully if replication is all green.

Starting the Failover Manager Tool
To start the Failover Manager tool:
1. Launch **Integrated Configuration Environment** (installed as part of Unified CCMP). In the **Database Connection** dialog box, set:
   - **Server Name**. Enter the name of the primary database server.
   - **Database Name**. Enter the name of the Unified CCMP database that was installed when setting up the Database Component. If you accepted the default value, this will be **Portal**.
   - **Authentication**. Select Windows Authentication.

2. Click **OK**. The ICE Cluster Configuration tool starts by default.

3. In the **Tools** drop-down, select **Failover Management**. The Failover Manager tool is displayed, showing:
   - the Unified CCMP service types that support failover
   - the service that is currently active for each
   - where available, the currently inactive service that can used for failover.

For each service type, the currently active service is shown as a depressed button, and identified by [active]. The inactive service is shown as a raised button that can be clicked to select it (see Figure 4.1 "Failover Management ICE Tool").

**Note**
This display simply indicates the active and inactive services that have been configured in your Unified CCMP installation. It does not indicate the health of the services. Before performing a failover, you should make sure that both services are fully operational.
Performing a Failover Operation

To start a failover operation:

1. In the Failover Manager tool, identify the service to be switched.
2. Identify the service to be switched, and click on the raised button of the currently inactive service to display the Manual Failover Wizard confirmation dialog box.
3. If you want to restart the new active service when the failover completes (the default option), select the **Restart services when complete** check box. If you do not want to restart the new active service when the failover completes (for example, if you want to perform other maintenance at the same time), clear the check box.

**Caution!**
Before continuing, make sure you really want to perform the failover at this time. The process may take some time to complete, and once it starts, it cannot be interrupted. During this time, neither the old active service nor the new active service will be available.
4. If you are sure you want to start the failover, click **Next**. The failover process may take some time to complete. The **Manual Failover Wizard** dialog box shows the progress and status for each step. A green tick means that the step completed successfully and a red cross means that the step completed but there was an error which needs to be fixed before the failover can continue.

5. Once the wizard has finished, click **Finished** to return to the main Failover Manager screen.

6. Confirm that the old service has stopped and the new service is running as follows:
   a. In ICE, select the Service Manager tool.
   b. Verify that the old service has stopped. If not, select it and click **Stop Selected**.
   c. If you selected the **Restart services when complete** option for the failover, verify that the new service has started, and, if not, select it and click **Start Selected**.

7. If the failover reported an error, then when the wizard finishes, neither the old service nor the new service will be running. The error message will help you identify and fix the problem and retry the failover, or you can restart the original active service. Contact your vendor support if you need further help or advice.

---

**More About Failover Manager**

This section describes the failover actions for each of the Unified CCMP services.

**Provisioning Service**

Provisioning service failover has the following steps:

- stop the provisioning service on the server on which it is currently running.
- migrate the active token.
- if requested, start the provisioning service on the new active server.

**Data Import Service**

Data import service failover has the following steps:

- stop the data import server service on the server on which it is currently running.
- migrate the active token.
- if requested, start the data import server service on the new active server.
Service Manager

About Service Manager
The Service Manager enables you to monitor, start and stop Unified CCMP services from a central location.

Using Service Manager

Note
To use Service Manager to start and stop services you need to be logged in to Windows as a domain user with permission to start and stop services.

Starting Service Manager
To start the Service Manager tool, perform the following steps on the primary database server:
1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database Connection dialog box, set:
   - Server Name. Enter the name of the primary database server.
   - Database Name. Enter the name of the Unified CCMP database that was installed when setting up the Database Component. If you accepted the default value, this will be Portal.
2. Click OK. The ICE Cluster Configuration tool starts by default.
3. In the Tools drop-down, select Service Manager. The Service Manager tool is displayed, showing a table of Unified CCMP services including the machine name they are installed on, the service name and the current status (Running, Starting, Stopping or Stopped).

Starting Services
To start one or more Unified CCMP services, on the primary database server:
1. In the Service Manager tool, click on the service or services you want to start. If you want to start all or most of the services, you can select the All check box, then, if required, click on any services you do not want to start. Select the All check box again to deselect all the services in the list.
2. Click Start Selected.
3. A dialog box opens, reporting the status of each service as it is started. Click **Close** when complete.

If a service is already started then no action is taken.

**Stopping Services**

To stop one or more Unified CCMP services, perform the following steps on the primary database server:

1. In the Service Manager tool, click anywhere on each service you want to stop. If you want to stop all or most of the services, click **Select/Deselect All**, then, if required, click on any services you do not want to stop. Click **Select/Deselect All** again to deselect all the services in the list.

2. Click **Stop Selected**.

3. A dialogue box opens, reporting the status of each service as it is stopped. Click **Close** when complete.

If a service is already stopped then no action is taken.

**Restarting Services**

To stop and restart one or more Unified CCMP services, perform the following steps on the primary database server:

1. In the Service Manager tool, click anywhere on each service you want to restart, to select the service. If you want to restart all or most of the services, click **Select All**, then, if required, click on any services you do not want to restart. Click **Deselect All** to deselect all the services in the list.

2. Click **Restart Selected**.

3. A dialog box opens, reporting the status of each service as it is stopped and restarted. Click **Close** when complete.

If a service is already stopped then it is just restarted.

**Sorting Services**

The Service Manager tool enables you to sort the Unified CCMP services by machine name, service name or current service status. To do this, perform the following steps on the primary database server:

1. In the Service Manager tool, click the column heading of the column you want to sort on. The list of services is sorted in ascending order according to the contents of that column.

2. If you want to sort the services in descending order, click the column name again. The list of services is displayed in descending order.
Filtering Services

The Service Manager tool enables you to filter the list of services by machine name, service name or service group.

Setting a Filter

1. In the Service Manager tool, select the filter or filters you require:
   - To filter by machine name, start typing the machine name or part of the machine name into the text box. The list of services is updated as you type, to show only those that contain the letters you specify.
   - To filter by service name, select the arrow beside the text box to display the list of available service names, and select the service name you want to filter by.
   - To filter by service group, select the arrow beside the text box to display the list of available service names, and select the service group you want to filter by.

2. The list of services is filtered according to the filter or filters you specified.

Clearing a Filter

To clear all the filters, select the icon beside the filter boxes (only shown if you have set some filters).

To clear an individual filter do one of the following:
   - To clear the filter for the machine name, delete the characters in the Machine Name text box.
   - To clear the filter for the service name or service group, select the blank entry from the drop down list.

Refreshing the Filtered List

To refresh the list of services, but retain the current filters, click Refresh.

Reloading the List of Services

To clear all filters and reload the servers and services from the database, click Reload.

Using the Shortcut Menu

Service Manager also has a shortcut menu. Right-click anywhere in the list of services to see a shortcut menu with the following options:
   - Select/Deselect All
   - Start All
   - Stop All
• Start Selected
• Stop Selected
• Apply Filter
• Clear Filter.
System Properties Manager

About System Properties Manager
The System Properties Manager enables you to view and set Unified CCMP system properties.

Using System Properties Manager

Starting System Properties Manager
To open the System Properties Manager tool, perform the following steps on the server where the properties need to modified.

1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database Connection dialog box, set:
   - Server Name. Enter the name of the primary database server.
   - Database Name. Enter the name of the Unified CCMP database that was installed when setting up the Database Component. If you accepted the default value, this will be Portal.
2. Click OK. The ICE Cluster Configuration tool starts by default.
3. In the Tools drop-down, select System Properties Manager. The System Properties Manager tool is displayed, showing the Unified CCMP properties, grouped by property type and functionality.

The following property types are available:
- Global properties (see section "Global Properties Tab")
- Local properties (see section "Local Properties Tab")
- Resource properties (see section "Resource Properties Tab")
- Capacity properties (see section "Capacity Properties Tab").

When you first start the System Properties Manager from ICE, the display shows the global properties. To see the other properties, click in the appropriate tab in the left hand pane.
System Properties Reference

Global Properties Tab

The Global Properties tab enables you to view and configure system wide items and items that affect multiple Unified CCMP components.

The properties are grouped as follows:


- **Active Directory Password.** The password used by Active Directory.

- **Active Directory User Name.** The user name used by Active Directory.

Activity Monitor

This group specifies configuration information for the Activity Monitor. This group contains the following properties:

- **Provisioning Warn Threshold.** The number of seconds after which an item or membership in the provisioning queue is shown in the middle (orange) band of the Activity Monitor.

- **Provisioning Max Threshold.** The number of seconds after which an item or membership in the provisioning queue is shown in the top (red) band of the Activity Monitor.

Code Lookup, supported equipment types

This group specifies information about equipment types. This group contains the following property:

- **Code Lookup and Supported Equipment Types.** The type of equipment that is used to import codes into the Unified CCMP database. Currently the only supported value is CRT_CICM (equipment type Cisco CICM)

Database Lock Configuration

This group specifies the timeout values used in the database for the importer and provisioning services. This group contains the following properties:

- **Lock Importer Acquire Timeout.** The time that the importer will wait to acquire a lock before timing out. The setting is entered in hh:mm:ss format.
- **Lock Importer Retry Rate.** The number of times the importer service will try to gain a lock on a database item before failing the item.

- **Lock Provisioning Acquire Timeout.** The time that the provisioning service will wait to acquire a lock before timing out. The setting is entered in the format hh:mm:ss.

- **Lock Provisioning Retry Rate.** Controls the number of times the provisioning service will attempt to gain a lock on a database item before failing the item.

**Gadget Management**

This group specifies the gadget management settings. This group contains the following properties:

- **Default Welcome Gadget.** The GUID of the default gadget that is shown on the gadget canvas if no App is selected. Set the value to “00000000-0000-0000-0000-000000000000” for none. Do not change this value unless instructed to by your vendor support.

- **Gadgets Cache Expiration Period.** The time period in seconds after which a cached gadget definition expires and is removed from the gadget cache. To disable the gadget cache during gadget development, set this to zero. For normal production use, this should be set to a non-zero value.

- **Gadget File Path.** The file path to a location on the web server where gadget files are located (used during gadget development only). Each gadget file name must match the name of the gadget it contains. If the gadget cache expiration period is zero, then Unified CCMP will first look for gadget files in this location and only load a gadget from the database if the gadget is not found here. For normal production use, this should be set to the empty string.

**Importer State**

This group specifies the import data settings. This group contains the following properties:

- **Bow Wave Duration Hours.** The time period in hours relative to a cluster resource creation date that constitutes the bow wave period. The value is between 1 and 24.

- **Bow Wave Effective From.** The effective from date for dimensions created during a bow wave.

- **Last Cluster Update.** The date and time the cluster was last updated (read-only).

**Local Login Security**

This group specifies the way that Unified CCMP logins are authenticated. This group contains the following properties:

- **Max Password Length.** The maximum number of characters allowed in a password.

- **Min Password Length.** The minimum number of characters allowed in a password.

- **Minimum Password Lifetime.** The minimum number of days that a password can be used for, before it is possible to change it.
• **Password Expiry.** The number of days before a password expires and has to be changed, measured from the date that the password was last changed.

• **Password Format.** The required password format. This field can also be set in the web application using **Settings > Security Settings > Password Format.** If one of predefined password formats (Low Security, Medium Security, Medium/High Security or High Security) is chosen in the web application, this field is automatically populated with the corresponding expression. This field is a .NET regular expression, except that the expression `{MIN_MAX}` can also be used to specify that the password length must lie between the values specified for **Min Password Length** and **Max Password Length.** For example, if Min Password Length is 8 and Max Password Length is 20, then `{MIN_MAX}` is equivalent to `{8,20}` in the .NET regular expression syntax.

• **Password Hash Algorithm.** Specifies the algorithm for encoding user passwords. To change the encoding of existing passwords, in the web application User Manager tool, set **User must change password at next login** for each user. The default is set to **SHA256.**

• **Password History.** The number of previous passwords that are saved and cannot be reused when a user password is changed.

• **Password Reuse Time.** The minimum number of days that must elapse before a previous password can be reused.

• **User Lockout.** The number of failed login attempts that a user is allowed before their account is locked.

**Login Authentication Configuration**

This group specifies the way that Unified CCMP logins are authenticated. This group contains the following properties:

• **Adfs Metadata Url:** The Active Directory Federation Services metadata URL.

• **Credential Metadata Expiration Period.** Specifies the time in seconds that the user’s login is cached before being re-authenticated. This re-authentication is internal, and not visible to the user. Choose a longer cache expiry to reduce the traffic between the Unified CCMP Web/App server and the authenticating server.

• **Credential Cache Expiration Type.** Specifies the way in which the expiry period for re-authentications is determined. One of:
  
  • **Absolute Expiry:** the expiry period for re-authentication is measured from the last authentication, whether or not the user has been active on the system since that time.
  
  • **Sliding Expiry:** the expiry period for re-authentication is measured from the last time the user was active on the system, or from the last re-authentication, if that was later.

• **Disable Inactive User Accounts Time Period.** Disable all non-system users that have not logged into the application for a set time period. Default is set to 30 days.
- **Enabled Login Types.** Specifies which authentication modes can be used by the user to login to the system. Multiple authentications can be used for the same user. The authentications modes supported are:
  - Local.
  - Windows.
  - ADFS.
- **Ext Auto Create User.** Creates a user for logins that were successfully authenticated against an external provider. One of True or False.
- **External Signout.** When you logout from the web application, you will also be logged out of the identity provider. One of True or False. Defaults to True.
- **Override Idle Timeout Exceptions:** When set to True, all idle user sessions are timed out, regardless of the application page the users are viewing.

**Media Upload**
This group specifies the default behavior for uploading media. This group contains the following properties:
- **Media File Accepted Formats.** A comma separated list of file extensions that are valid for media files.
- **Media Share.** The network share name where WAV files uploaded through the Unified CCMP user interface will be placed for replication to the CVP Media Server.

**Miscellaneous**
This group specifies some miscellaneous properties. This group contains the following properties:
- **Agent Description Field Mandatory.** Whether the agent description field is mandatory when agents are created and edited. One of True or False.
- **Agent Description Format.** A regular expression defining the characters that are not allowed in the agent description field. Special characters must be escaped. For example, if you wanted to exclude the characters “z”, “&” and “*”, you would enter \[z\&\*].
- **Delete Person With Last Agent Member.** Determines if the associated person dimension will be deleted when the last agent member is deleted.
- **Display Purge Button Stuck Seconds.** The number of seconds to wait before determining that an item in synchronizing or pending state is blocked. Once this time has been exceeded a purge button is displayed in the web application.
- **Menu Items.** Custom applications can be added to the menu bar by the inclusion of a display name and URL. Items separated by a semi colon.
- **Product Name.** The name of the product to display in the user interface, allowing organizations to personalize the product.
- **Prov Agent State Trace Enabled.** Determines whether Resource Manager users can enable the ICM State Trace feature on agents. ICM State Trace provides enhanced logging information when individual agents move from one state to another.

- **Query Parameter Boundary.** The maximum number of parameters in an SQL query before a sub query is generated.

- **Resource Internal Name Create Enabled.** Whether a resource internal name can be created. One of True or False.

- **Resource Internal Name Edit Enabled.** Whether a resource internal name can be edited. One of True or False.

- **Show Only Reporting Timezones.** Determines whether only timezones supported for reporting re displayed in the web application, rather than all timezones.

- **Show Only UI Translation Cultures.** Determines whether only cultures which have a UI translation are displayed in the web application rather than all cultures.

**Note**

Non UI cultures are not fully supported. All unrecognized cultures will default the date format to en-US.

- **Supported Languages.** The culture codes for the languages supported by the installation. Click the drop-down list to see and select the supported languages.

- **Supported Peripheral Types.** The peripheral types that can be associated with resources such as agents. Click the drop-down list to see and select the supported peripheral types.

- **Web Server Debug Info Disclosure.** Whether server and culture information is shown in the menu bar of the web application. One of True or False.

**Other Security**

This group specifies other security options. This group contains the following properties:

- **Enable User Copy.** Determines whether the user copy feature is available in the Unified CCMP web application. One of True or False.

- **Inherit Permissions Default.** Determines whether the Inherit Permissions check box is selected by default when a new folder is created. One of True or False.

- **Push Policy Changes to Child.** Determines whether the Change Permissions for Subfolders check box in Security Manager is selected by default when the user selects Change Permissions. One of True or False.

**Partitioning State**

This group specifies database partitioning options. This group contains the following properties:
- **Last Partition Metadata Change.** The date and time that the partition metadata was last updated (read-only).

**System Limits**
- **Max Dimension Associated Items.** The maximum number of associated items that can be listed for a dimension in the web application.
- **Max Dimension Drop Down List Items.** The maximum number of dimension items that can be shown in a drop-down list in the web application before the list is disabled.

**User Provisioning**
This group specifies the default behavior when creating users. This group contains the following properties:
- **Create Advanced Users Groups.** Determines if an advanced users group is created when a folder is set to not inherit permissions. One of True or False.
- **Create Basic Users Groups.** Determines if a basic users group is created when a folder is set to not inherit permissions. One of True or False.
- **Create Supervisor Users Groups.** Determines if a supervisor users group is created when a folder is set to not inherit permissions. One of True or False.
- **Default Home Folder Role.** The role that is automatically associated with a user on their home folder when the home folder is created.
- **Default Tenant Administrators Global Role.** The global role that is automatically associated with the Administrators group when a new Tenant or policy root folder is created.
- **Default Tenant Administrators Role.** The role that is automatically associated with the Administrators group when a new Tenant or policy root folder is created.
- **Default Tenant Supervisors Global Role.** The global role that is automatically associated with the Supervisors group when a new Tenant or policy root folder is created.
- **Default Tenant Supervisors Role.** The role that is automatically associated with the Supervisors group when a new Tenant or policy root folder is created.
- **Default Tenant Users Global Role.** Specifies the global role that is automatically associated with the Users group when a new Tenant or policy root folder is created.
- **Default Tenant Users Role.** Specifies the role that is automatically associated with the Users group when a new Tenant or policy root folder is created.
- **Home Folder Suffix.** The suffix that is appended to the username when a home folder is created for a user.

**Local Properties Tab**
The Local Properties tab enables you to view information from the local machine.
The properties are grouped as follows:

**Checksum**
This group displays database validity information. This group contains the following property:
- **Is Database Valid.** The value determining whether or not the database is valid. (read-only).

**Partitioning State**
This group specifies partition table information. This group contains the following property:
- **Last Partition Tables Refresh.** The date and time of the last partition table refresh (read-only).

**Versioning Group**
This group displays the following version numbers. This group contains the following properties:
- **Build Version.** The build cycle that the installation was taken from (read-only).
- **Schema Version.** The version of the database schema being used (read-only).

**Resource Properties Tab**
The Resource Properties tab enables you to view and configure the way that resources are handled in Unified CCMP.
The properties are grouped as follows:

**Resource Items**
This group lists each resource item. Each resource item has the following properties:
- **TaxonomyEnabled.** Determines whether resources of this type are available to the taxonomy (hierarchy) feature of Unified CCMP.

**Resource Members**
This group lists each resource membership. Each resource membership has the following properties:
- **TaxonomyEnabled.** Always False for resource memberships.

**Capacity Properties Tab**
The Capacity Properties tab enables you to view and configure the capacity rules for the remote equipment. A capacity rule may apply to:
- all equipment of a specified type in the cluster, or only to a specific equipment instance
- all tenants in the cluster, or only to a specific tenant.
The properties of the capacity rules are determined by the remote equipment. The properties are grouped by capacity rule. Each capacity rule has the following properties:

- **CapacityId.** The database primary key of the capacity rule (read-only).
- **ItemType.** The resource type that the capacity rule applies to (read-only).
- **MemberType.** The membership that the capacity rule applies to, or <None> (read-only).
- **ViaMemberType.** The additional membership that the capacity rule applies to, or <None> (read-only).
- **Description.** The description of this capacity rule (read-only).
- **MaxCapacity.** The maximum number of resources or memberships allowed under this capacity rule. This value can be edited if the System property is False, or if the ClusterInstance property is <All>. Otherwise this value is read-only.
- **ClusterType.** The cluster type of the remote equipment that the capacity rule applies to (read-only).
- **ClusterInstance.** The remote equipment that the capacity rule applies to (read-only). One of:
  - <All>, if the capacity rule applies to all instances of that equipment type
  - the specific cluster name of the remote equipment, if the capacity rule only applies to a single instance of that equipment type.
- **TenantName.** The tenant that the capacity rule applies to (read-only). One of:
  - <All>: if the capacity rule applies to all tenants on the specified equipment
  - the specific tenant name, if the capacity rule only applies to a single tenant on the specified equipment.
- **CreationDate.** The date that this capacity rule was created (read-only).
- **ModifiedDate.** The date that this capacity rule was last modified (read-only).
- **System.** Determines whether this the capacity rule is a default system value, or whether it was added as a customization (read-only). One of:
  - **True:** the rule is a default system value
  - **False:** the rule is a customization.
- **Enabled** Determines whether this capacity rule should be considered when creating a resource or membership. One of **True** or **False**.
Gadget Provider Manager

This feature is not supported.
Custom Dimension Editor

About the Custom Dimension Editor

Description
The ICE Custom Dimension Editor enables you to create and edit custom dimensions.

Custom Dimensions
Custom dimensions are user-defined dimensions that store user data in Unified CCMP. This data can be exported from the database, used in custom reports and also accessed programmatically using the Unified CCMP Web Services APIs. Each item in a custom dimension can have free-format attributes, defined as name-value pairs.

Unified CCMP provides ten custom dimensions, Custom0, Custom1, Custom2, . . . Custom9. Each custom dimension can be used to store any number of items, and each item can have any number of custom attributes. Each item in a custom dimension can have the same attributes, or different items can have different attributes, depending on the requirements. The Custom Dimension Editor does not check the attribute names or content, so it is up to the user to enforce any rules that apply.

Using the Custom Dimension Editor

Starting the Custom Dimension Editor
To start the ICE Custom Dimension Editor:

1. Launch Integrated Configuration Environment (installed as part of Unified CCMP). In the Database Connection dialog box, set:
   - Server Name. Enter the name of the primary database server.
   - Database Name. Enter the name of the Unified CCMP database that was installed when setting up the Database Component. If you accepted the default value, this will be Portal.
2. Click OK. The ICE Cluster Configuration tool starts by default.
3. In the Tools drop-down, select Custom Dimension Editor. The Custom Dimension Editor is displayed, showing Custom0 to Custom9 tabs and a grid listing the custom dimension items.
Adding a Custom Dimension Item

To add a custom dimension item:

1. Start the ICE Custom Dimension Editor (see section "Starting the Custom Dimension Editor").
2. Click the custom dimension corresponding to the item you want to add. For example to add a new item to Custom2, click the Custom2 tab.
3. In the grid, enter a name for the custom dimension item, and optionally, a description.
4. To add attributes:
   a. In the attribute column, click Add (shown as Edit if the custom dimension item already has one or more attributes).
   b. In the attributes dialog box, in the blank row, enter the name of the attribute and the required value. All values are stored as strings.
   c. Add additional attribute rows as required. When you have finished adding attributes, click OK to return to the Custom Dimension Editor.

Note

A custom dimension item cannot have two attributes with the same name. Unified CCMP does not carry out any other validation on the attribute names or values, so if you require specific attributes to be present, or for attributes to have a specific range of values, your must enforce this yourself.

5. To save and action your changes, either click the Save icon in the tool bar or select File > Save from the menu. The custom dimension item is created in the /Shared folder in the Unified CCMP folder tree.

Editing a custom dimension item

To edit a custom dimension item:

1. Start the ICE Custom Dimension Editor (see section "Starting the Custom Dimension Editor").
2. Click the custom dimension tab that contains the item you want to edit.
3. In the grid, locate the item you want to edit.
   - You can change the name or description of a custom dimension item directly in the grid.
   - To edit the attributes, click Edit beside the item (or Add if the item has no attributes yet) then make the required changes to the attributes.
   - You can change the name or value of an attribute directly in the grid.
To add an attribute, in the blank row, enter the name of the attribute and the required value. All values are stored as strings.

To delete an attribute, select the attribute row you want to delete, then press Delete. You can select multiple rows to delete multiple attributes.

4. When you have finished, click OK to return to the Custom Dimension Editor.

5. To save and action your changes, either click the Save icon in the tool bar or select File > Save from the menu.

Deleting a Custom Dimension Item

To delete a custom dimension item:

1. Start the ICE Custom Dimension Editor (see section "Starting the Custom Dimension Editor").

2. Click the custom dimension tab that contains the item you want to delete.

3. In the grid, select the check box beside the item or items you want to delete. You can click Select All to select all items in the grid, or Select None to clear all the selections you have made in the grid.

4. When you have selected the item or items you want to delete, click Delete Selected.

5. To save and action your changes, either click the Save icon in the tool bar or select File > Save from the menu.

Tip
You can also use the classic Resource Manager in the Unified CCMP web application to delete custom dimension items.

Moving a Custom Dimension Item

The Custom Dimension Editor creates all custom dimension items in the /Shared folder. You can use the classic Resource Manager in the Web UI to move custom dimension items to other folders if required. See the User Guide for Cisco Unified Contact Center Management Portal or the online help for more information.

The Custom Dimension Editor does not show the folder path of an item, and can only create items in the /Shared folder. But if the item has been moved, the new location is retained when the item is edited.
ICE Diagnostic Support

About ICE Diagnostic Support

Diagnostic Features
ICE provides two features to help you view and collect status information and log files from the servers in the Unified CCMP cluster.

- ICE supports integration with Cisco’s Diagnostic Portal, and provides a simple, central way to view diagnostic information from any server in the Unified CCMP cluster.
- ICE provides a wizard that enables you to collect log files from all the servers in the cluster and package them into a single zip file that can be set to your vendor support in case of problems.

Before you can use the diagnostic support features provided in ICE, you need to

- install the Cisco Diagnostic Portal on each physical Unified CCMP servers if not already installed.
- configure ICE integration with the Diagnostic Portal on each physical Unified CCMP server (see section "Configuring ICE Integration with the Diagnostic Portal").

Using ICE Diagnostic Support

Installing the Cisco Diagnostic Portal
Perform this step for each physical Unified CCMP server in the product cluster. For example, if you have a dual-sided deployment, and a two tier installation, with separate Database and Web/Application servers, you should install the Cisco Diagnostic Portal on the Side A Database Server, the Side A Web/Application server, the Side B Database Server and the Side B Web/Application server.

Install the Diagnostic Portal as described in the Installation and Configuration Guide for Cisco Unified Contact Center Management Portal.

Configuring ICE Integration with the Diagnostic Portal
Use ICE to perform this step for each physical server in the product cluster. When you configure ICE integration with the Diagnostic Portal for one ICE server resource on a physical server, the other ICE server resources are automatically updated to use the same values.
For example, if you have a single-sided deployment, with an all-in-one server running both the Database and Web/Application components, a Unified CCE server and an ICM server, you need to configure ICE integration with the Diagnostic Portal on:

- either the Unified CCMP Database Server or the Unified CCMP Web/Application server (the configuration will automatically be propagated to the other one)
- the Unified CCE server
- the ICM server

**To configure ICE for use with the Diagnostic Portal on a physical server:**

1. Identify a Windows user for ICE to use to access the Diagnostic Portal. If you have a single-sided all-in-one deployment, then you can use the local wsmadmin user that was created when you installed the Diagnostic Portal. Otherwise you will need to create a domain user.

2. Select **Start > Computers > Manage, select System Tools > Local Users and Groups > Groups** to view the available security groups.

3. Add the required user to the Diagnostic Framework Users Security group. The name of this group will be different for each type of server, but will always end in **DiagnosticFrameworkUsers**. For example, on a Unified CCE server, the group is called **ICMDiagnosticFrameworkUsers**.

4. In ICE, in the **Resources** tab, select a logical server on this physical server, click the **Component** tab for the resource and set the following:
   - **Diagnostic Portal User Name**: the required user name. If you are using a domain user you need to specify the user name in the format `<username>@<domainname>`, where `<username>` is the Windows user name and `<domainname>` is the fully qualified Windows domain name, for example, `dp_user1@testdomain.local`.
   - **Diagnostic Portal Password**: the password for the specified user.
   - **Diagnostic Portal Service URL**.

These details will automatically be propagated to any other servers located on the same physical server.

Repeat for the other physical servers in the system.

**Viewing Logs**

To view a log or trace log:

1. Open ICE and select the Cluster Configuration tool.

2. Click **Resources** to view the logical server resources in the Unified CCMP cluster.

3. Right click on the logical server resource for which you want to view the logs, and select **Components**, then select the required component. Finally select **View Logs** or **View Trace Logs** to see the selected log information.